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About this document 

Scope and purpose 

This application note describes the BGT60LTR11AIP Radar Shield2Go (S2GO RADAR BGT60LTR11)  and gives an 
overview of its functions. The Shield2Go is an ultra-small Infineon Technologies PCB standard, which comes 

with different ICs on it intended for different use cases. 

Intended audience 

The intended audience for this document are engineers, prototype creators, hobbyists and makers – basically, 

anyone who wants to work hands-on with radar, but without the need to deal too much with the development 
process, focusing more on the application outcome. 

  

http://www.infineon.com/
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1 Introduction  

1 Introduction 

1.1 Overview 

The Radar Shield2Go can be used independently as a “plug-in” radar sensor (e.g., with Arduino form factor 
boards or another microcontroller) to detect motion and direction of motion by using only two GPIOs (TD and 
PD) in autonomous mode (default). The board comes with two potentiometers and switches, making it easy to 
adjust the four QS signals of the radar mechanically. The switches can be used to switch between autonomous 

and SPI modes. 

The Shield2Go comes with castellated holes to ensure several connection styles. 

The Shield2Go family is recommended to be used with either Infineon’s XMC™ maker board series (e.g., 

XMC1100 Boot Kit/XMC1400 Arduino/XMC 2Go/XMC4700 Relax Kit) or Arduino boards (e.g., Rev3/MKR1000). 

The BGT60LTR11AIP Shield2Go demonstrates the features of the BGT60LTR11AIP MMIC and gives the user a 
“plug and play” radar solution. 

 

Figure 1 Radar Shield2Go with BGT60LTR11AIP 

1.1.1 Hardware and third-party software 

The Radar Shield2Go is compatible with the Arduino IDE, Platform.IO with Arduino extension, and Infineon’s  

ModusToolbox™ (formerly Cypress) SDK. You can find a detailed user guide to integrate the BGT60LTR11AIP 

library on the free and open-source repository GitHub [5].  

Note: To use the existing library in Infineon’s ModusToolbox™ SDK, the integration is done manually with 
customized manifests, described on Infineon’s GitHub. 

The Shield2Go concept can also be attached to any board with an Arduino Uno form factor, by using an 

Infineon MyIoT adapter.  

https://www.infineon.com/cms/en/product/evaluation-boards/kit_xmc11_boot_001/
https://www.infineon.com/cms/en/product/evaluation-boards/kit_xmc1400_arduino/
https://www.infineon.com/cms/en/product/evaluation-boards/kit_xmc_2go_xmc1100_v1/
https://www.infineon.com/cms/en/product/evaluation-boards/kit_xmc47_relax_v1/
https://www.arduino.cc/en/software/
https://platformio.org/
https://www.cypress.com/products/modustoolbox?utm_source=GoogleCPC&utm_medium=GoogleAds&utm_campaign=g-css-eu-en-g-smartwacheswristbands_products_ModusToolbox%E2%84%A2&gclid=CjwKCAjwzOqKBhAWEiwArQGwaEmZHuf7jyqyyfPRx62aXaCT0AZzQEzxWMxAIoIUi88EZ8mAi0PZdRoC8OAQAvD_BwE&gclsrc=aw.ds
https://github.com/Infineon/arduino-radar-bgt60/blob/master/examples/interruptMode/interruptMode.ino
https://www.infineon.com/cms/en/product/evaluation-boards/my-iot-adapter/
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1 Introduction  

1.1.2 Quad-state input pins 

The MMIC has four quad-state input pins (QS1 to QS4) that give the performance parameters flexibility when it 
is running in autonomous mode. These pins are used to configure the chip, as explained in section 4.2.2. 

QS1 sets up the three modes of the MMIC (autonomous by default), QS2 controls the detector comparator 
threshold, QS3 sets up the hold time of the “target detect” output, and QS4 is used to select the device 
operating frequency by configuring the phase-locked loop (PLL). 

QS1 is controlled by a dual-state switch and QS4 by a tri-state switch. QS2 and QS3 can be adjusted by two 
rotatable potentiometers.  

In autonomous mode, the detection threshold (set via potentiometer R_QS2) has 16 different levels to fulfill a 

configurable detection range from 0.5 m up to 7 m with a typical human-target radar cross-section (RCS). The 
hold time is also configurable as 16 levels in autonomous mode via the potentiometer that controls QS3, which 

allows detection status to be held for up to 30 minutes (see section 4.2.5). 

1.1.3 SPI communication 

The MMIC also supports SPI mode by changing the operation mode with the QS1 pin (see section 4.2.3). In this 

mode, the raw radar data can be extracted from BGT60LTR11AIP for signal processing on a PC or an external 

MCU using SPI. This sampled radar data can be used to develop customized algorithms. The SPI mode offers 

the possibility to control the MMIC radar completely via SPI. 

1.2 Key features 

• Easy motion and direction of motion detection of an object with only two GPIOs 

• Programmable in Arduino IDE and Platform.IO (VS Code extension) 

• Configurable detection range from 0.5 m to 7 m 

• LEDs that blink when presence or movement direction is detected 

• Potentiometers and switches to adjust the settings of the radar (QS) 

• Super-small (48.80 mm x 23.90 mm) board design with Infineon’s Shield2Go format 

• 60 GHz transceiver BGT60LTR11AIP MMIC with one transmitter and one receiver unit 

1.3 Potential applications 

• Prototyping smart home appliances 

• Security applications 
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2 Board and pin-out overview  

2 Board and pin-out overview 

This section gives an overview of Infineon’s standardized Shield2Go pin-out. 

 

Figure 2 The BGT60LTR11AIP Radar Shield2Go (top view) 
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2 Board and pin-out overview  

2.1 Board dimensions 

 

Figure 3 Layer stack-up of the BGT60LTR11AIP Radar Shield2Go 
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3 Getting started  

3 Getting started 

3.1 Overview 

The Radar Shield2Go needs an MCU to communicate and run custom code. However, if connected to a power 
source, the direction and motion LEDs blink in the presence of an object even without an MCU connected. The 

target detect (TD) pin is an active low pin. Hence, when no target is detected, the voltage level appears to be 

3.3 V on this pin. The phase detect (PD) pin voltage varies, depending on the direction of the moving object. 
While the target is approaching, the pin puts out 3.3 V, and when the target is departing from the radar, it puts 
out close to 0 V. These pins can be read from analog pins or digital pins TD and PD. 

Move the switch lever “QS1: mode” to the left position to set up the radar in autonomous mode, and apply 3.3 V 

(pin 7) and GND (pin 6) to the corresponding power pins of the Shield2Go. Note that the power source offers a 
minimum of 150 mA. If power is supplied, the PWR LED turns on. Now, the radar can recognize any movement 

or direction of an approaching or departing object. The blue LED lights up when object movement is detected, 
and the red LED lights up when the target is approaching or departing. See section 5.3 for more information 
about LED behavior.  

The radar now works on its own, without any other MCU needed. However, for reading/writing the radar MMIC, 
connect one of the recommended MCUs mentioned in section 1.1.1. Note that any MCU will work if the voltage 

levels are the same (3.3 V), otherwise level shifting is mandatory. Because Infineon offers software libraries 

compatible with Arduino and Infineon XMC™ boards, software setup for other MCU platforms might be more 

difficult. 

Infineon’s software libraries and installation guides are open-source and available on Infineon’s GitHub 

channel [5]. The Radar Shield2Go needs to be connected with the pin headers of the MCU board either with 
wires or via stacking onto an adapter (e.g., Infineon’s MyIoT adapter for Arduino). 

3.2 Hardware setup 

Connect the Radar Shield2Go to any microcontroller and supply the board with a 3.3 V DC (150 mA) power 
source (which can usually be driven by the MCU board). 

 

Figure 4 Radar Shield2Go on top of Infineon’s MyIoT adapter and Arduino-compatible XMC1100 

Boot Kit (very bottom) 

 

https://github.com/Infineon/radar-bgt60/wiki/Ino-Getting-Started#hardware-setup
https://github.com/Infineon/radar-bgt60/wiki/Ino-Getting-Started#hardware-setup
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3 Getting started  

 

Figure 5 Shield2Go connector S1 schematics 

After that, connect the microcontroller board via USB to your computer and continue with the software setup as 
described in section 4. 

Note: By using Infineon’s MyIoT adapter, you can easily plug up to three Shield2Gos on an Arduino Uno 
Rev3 form factor due to the integrated level shifter on the adapter. The adapter works with 5 V 
(e.g., Arduino Uno Rev3) and 3.3 V shields (e.g., XMC1100 Boot Kit/XMC4700 Relax Kit). Please read 

the MyIoT adapter manual for more details on how to configure the voltage shifting. 

The following boards are recommended for use and are compatible with the Arduino IDE and Platform.IO 

 

Figure 6 Recommended boards 

 

 

https://www.infineon.com/cms/en/product/evaluation-boards/my-iot-adapter/
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3 Getting started  

• XMC2Go is equipped with Infineon’s powerful Arm® Cortex®-M0 based microcontroller XMC1100 and is the 
ideal board in Shield2Go form factor for tiny applications. 

• XMC1100 Boot Kit or XMC1400 Arduino are powerful microcontroller boards with Arduino Uno Rev3 form 
factor that offer the user more performance and GPIOs, including multiple buses (I2C, SPI), pulse-width 

modulation (PWM) signals, ADC, DAC, LEDs, and a breakable and reusable debugger for multiple purposes.  

• XMC4700 Relax Kit is an extremely powerful microcontroller board with Infineon’s Arm® Cortex®-M4 based 
microcontroller XMC4700. It also comes in an Arduino Uno Rev3 form factor, with an additional 80 GPIOs to 

use, and Ethernet. 

 

You can also use Arduino’s boards, such as the popular Arduino Uno Rev3 or the MKR1000 

Wi-Fi board. We have prepared examples of applications on the do-it-yourself website 

Hackster.IO for you – check out the Infineon_Team Channel for more information. 

 

Find all libraries and instructions to get started on Infineon’s GitHub repository. 

3.3 Software setup 

3.3.1 Required software for Infineon’s XMC™ boards  

• SEGGER J-Link, either for Windows or Linux (for XMC™) 

• Arduino IDE, either for Windows or Linux 

• XMC-for-Arduino (installed with Arduino IDE) 

• Radar BGT60LTR11 Library for Arduino on Infineon’s GitHub repository (installed with Arduino IDE, v2.0.0 or 

higher) 

• Follow these installation steps: 

− Install Arduino IDE. If you are new to Arduino, please download the program and install it first. 

− Install XMC™ board. The official Arduino boards are already available in the Arduino software, but other 
third-party boards such as the Infineon XMC™ MCU-based board need to be explicitly included. Follow 

the instructions in the link to add the XMC™ board family to Arduino. 

− Install the library. In the Arduino IDE, go to the menu Sketch > Include library > Library Manager. Type 
BGT60LTR11 and install the library. 

− Additionally, install SEGGER J-Link if you are using an Infineon XMC1100 Boot Kit or XMC4700 Relax Kit. 

Continue with the section below if you are using Infineon’s XMC™ microcontroller for Arduino 

3.3.2 Required software for Arduino  

• Arduino IDE, either for Windows or Linux 

• Radar BGT60LTR11 Library for Arduino on Infineon’s GitHub repository (installed with Arduino IDE, v2.0.0 or 
higher) 

• Follow these installation steps: 

− Install Arduino IDE. If you are new to Arduino, please download the program and install it first. 

− Install the library. In the Arduino IDE, go to the menu Sketch > Include library > Library Manager. Type 

BGT60LTR11 and install the library. 

https://www.infineon.com/cms/en/product/evaluation-boards/kit_xmc_2go_xmc1100_v1/
https://www.infineon.com/cms/en/product/evaluation-boards/kit_xmc11_boot_001/
https://www.infineon.com/cms/en/product/evaluation-boards/kit_xmc1400_arduino/
https://www.infineon.com/cms/en/product/evaluation-boards/kit_xmc47_relax_v1/
https://www.hackster.io/Infineon_Team
https://github.com/Infineon/arduino-radar-bgt60
https://www.segger.com/downloads/jlink
https://www.arduino.cc/en/main/software
https://github.com/Infineon/arduino-radar-bgt60
https://www.arduino.cc/en/Main/Software
https://github.com/Infineon/XMC-for-Arduino#installation-instructions
https://www.arduino.cc/en/main/software
https://github.com/Infineon/arduino-radar-bgt60
https://www.arduino.cc/en/Main/Software
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− Additionally, install SEGGER J-Link if you are using an Infineon XMC1100 Boot Kit or XMC4700 Relax Kit. 
Continue with the section below if you are using Infineon’s XMC™ microcontroller for Arduino 

3.3.3 Installation instructions for XMC™ microcontrollers 

You can also find the whole XMC-for-Arduino installation guide for Infineon’s XMC™ repository on GitHub. 

3.3.3.1 Prework for SEGGER J-Link 

In order to use and program the Infineon XMC™ microcontrollers in the Arduino IDE, SEGGER J-Link must be 
installed on your PC. Please follow this link to SEGGER J-Link and install the J-Link software and 
documentation pack for your operating system. If you have already installed DAVE™ – Development Platform 

for XMC™ Microcontrollers you can skip this step, as the respective drivers/programs are already installed on 
your system. 

 

Figure 7 Arduino configuration – installing J-Link software for XMC™ microcontrollers (not needed 

for Arduino) 

https://github.com/Infineon/XMC-for-Arduino
https://www.segger.com/downloads/jlink
https://infineoncommunity.com/dave-download_ID645
https://infineoncommunity.com/dave-download_ID645
https://raw.githubusercontent.com/infineon/assets/master/Pictures/J-Link_Packages.png
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3.3.3.2 Using Arduino IDE with XMC™ microcontroller 

 

Figure 8 Arduino IDE configuration – Preferences 

Paste the following URL into the “Additional Boards Manager URLs” input field under File > Preferences to add 

Infineon’s microcontroller boards to the Arduino IDE. (It is easier to copy – there is no clickable link.) 

https://github.com/Infineon/XMC-for-Arduino/releases/latest/download/package_infineon_index.json  

Note: The former “package_infineon_index.json” URL will no longer be maintained after version 1.4.0. 
Upcoming versions will not be shown as available in the board manager 

 

https://github.com/Infineon/XMC-for-Arduino/releases/latest/download/package_infineon_index.json
https://raw.githubusercontent.com/infineon/assets/master/Pictures/Preferences.png
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3 Getting started  

 

Figure 9 Arduino IDE configuration – Additional Boards Manager URLs 

To install the boards, please navigate to Tools > Board > Boards Manager... and search for “XMC”. You will find 
options to install the board files for the microcontrollers. Click “Install” to add the boards to your Arduino IDE. 

 

Figure 10 Arduino configuration – installing XMC™ library 

https://raw.githubusercontent.com/infineon/assets/master/Pictures/Preferences_JSON.png
https://raw.githubusercontent.com/infineon/assets/master/Pictures/Boards_Manager_Entry.png
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In the boards listed under Tools > Board, the XMC™ microcontroller boards are added and can be used from 
now on. 

 

Figure 11 Arduino configuration – choose your XMC™ board 

Note: This integration will only work for Arduino IDE 1.5 or above. 

The XMC1100 Boot Kit has limitations compared to the official Arduino boards (consult the XMC-

for-Arduino Wiki for more information). 
Refer also to the LICENSE.md/txt file for further information. 

Arduino 1.8.0 IDE might have problems with the XMC-for-Arduino releases.XMC-for-Arduino support 
for “arm-linux-gnueabihf” is only up to version 1.1. 

https://github.com/Infineon/XMC-for-Arduino/wiki
https://github.com/Infineon/XMC-for-Arduino/wiki
https://raw.githubusercontent.com/infineon/assets/master/Pictures/Board_List.png
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4 Radar modes setup  

4 Radar modes setup 

4.1 TD and PD signals 

With the Shield2Go you can adjust all four quad-state signals (QS1 to QS4) mechanically rather than via 
software. Use the potentiometers and switches to adjust all quad states in autonomous mode. In SPI mode, 

you can adjust all QS signals by changing the BGT60LTR11AIP registers. 

The default direction information is set to “approaching”. The truth table for the output pad voltage is shown in 

Table 1. 

Table 1 Truth table for the output pad voltage 

The BGT60LTR11AIP provides four quad-state inputs, QS1 to QS4. With one quad-state input, it is possible to 
get four states from one input pin. These pins are used to configure the chip. 

4.2 “Advance mode” and quad-state inputs 

On reset of the digital main controller and during the init sequence some chip input pins are sampled to 
determine the configuration the chip should start with. Figure 12 shows the schematics of the default 

configuration for the MMIC operation modes and settings. 

 

Figure 12 MMIC operation modes and settings (n.m. = not mounted) 

 

Output pad voltage Motion Approaching/Departing 

TD PD 

high high No N.A. 

low low Yes Departing 

low high Yes Approaching 
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4 Radar modes setup  

4.2.1 “Advance mode” 

When the PLL_Trig pin is “0” as the digital main controller wakes up from reset, the chip boots in basic mode 
(not advance mode). When the pin is kept at “1” during chip boot and QS1 is either GND or OPEN, pins SPIDI 
and SPICLK are also sampled to determine the PRT: dc_rep_rate (Reg7[11:10]). In addition, pins QS2 and QS3 
are evaluated by the ADC and converted into 4-bit values before each “mean window”. 

By default, the Radar Shield2Go is pulled to VDD_RF (1.5 V) with a 100 kΩ resistor R14; hence, “autonomous 
mode” is activated. Additionally, “advance mode” is activated. 

When this pin is 0, when the digital main controller wakes up from reset, the chip boots like earlier versions, 
only considering the four quad-state inputs below with their 2-bit information per pin. 

Table 2 PRT in “advance mode” 

4.2.2 Quad-state basics for adjustable QS1 to QS4 signals 

  

 

Figure 13 Overview of QS1 to QS4 signals on the BGT60LTR11AIP Radar Shield2Go from the top 

The quad-state inputs QS1 to QS4 enable configuration of four different states with one input pin. Figure 13 

shows the two switches QS1/QS4 and two potentiometers for the detector threshold (QS2) and hold time (QS3). 

Table 3 shows possible input states and the resulting internal signals in the binary description. Quad-state 
inputs are sampled at the start of the init sequence by the internal main controller at power-up. A change after 
this sampling has no effect. Resampling can be triggered by setting the reset pin or activating the soft reset by 
writing the corresponding bit in Reg15. The reset pin is by default pulled to VDD (3.3 V) via the 10 kΩ resistor R12. 

PLL_Trig SPI_MOSI SPI_CLK dc_rep_rate 

0 * * 1/2 (fuse dependent) 

1 0 0 1 

1 0 1 3 

1 1 0 0 

1 1 1 2 

 

Switch QS1: 

mode 

 

Switch QS4: 

mode 

Potentiometer R_QS2: 

threshold 
Potentiometer R_QS3: 

Hold time  

  

 



 

Application note 16 Revision 1.10 

  2023-05-10 

 

 

 

BGT60LTR11AIP Radar Shield2Go 
XENSIV™ 60 GHz radar 
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In order to have up to 16 settings for QS2 (threshold) and QS3 (hold time), the PLL_TRIG should be connected to 
VDD by removing R15 and placing R14 = 100 kΩ. This will put the MMIC into “advance mode”. Note that advance 

mode is set by default. 

4.2.3 QS1 – MMIC operation modes 

QS1 is used to select the mode of the chip. By default, it is recommended to use either (advance) autonomous 

mode or SPI mode. Advance mode allows the use of 15 instead of four threshold values for QS2 (threshold) and 

QS3 (hold time). By default, this board comes with autonomous (advance) and SPI mode settings. Change 
resistor R_QS1 to enable/disable the other modes, by soldering it, accordingly, as described in Table 3. 

Table 3 QS1 settings 

4.2.4 QS2 – detector threshold 

QS2 is used to select the detector threshold value; with the same radar cross-section as a target, a lower 

detector threshold value corresponds to a higher detection range, which is written into Reg2 as described in the 
user's guide to BGT60LTR11AIP [3]. 

Additionally, QS2 can be controlled by the 10 kΩ potentiometer R_QS2 to adjust the detector threshold. To 

increase the voltage, turn the knob counterclockwise; to reduce the voltage, turn the knob clockwise. 

   

Figure 14 Rotation direction of R_QS2 potentiometer – detector threshold 

Note: A low detection threshold results to a higher detection range, and vice-versa.  

 

 

Switch position –  

QS1 mode 

QS1 Operation mode of the 

MMIC 

PCB configuration 

Left position (floating) Open (default) Autonomous pulsed 

mode 

Not important (default) 

Right position 100 kΩ to VDD SPI mode with external 

9.6 MHz clock enabled 

(FH3840024Z) 

R_QS1* = 100 kΩ 

Right position VDD SPI mode R_QS1* = 0 Ω (default) 

* R_QS1 is assembled with 0 Ω, 0603 (imp.) 

Rotate potentiometer R_QS2 clockwise to reduce the detection threshold. 
Rotate it counterclockwise to increase the detection threshold. 
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Table 4 QS2 settings – detector threshold 

Due to mechanical tolerances and manufacturing differences in the potentiometer, it is difficult to predict the 
degree of rotation of the potentiometer. Table 5 gives an orientation for the configuration of the threshold, 

hence the radar detection range. Please note that your values may differ slightly from the values below. 

Table 5 Measured threshold vs. range of Radar Shield2Go in autonomous (advance) mode (for 
reference only) 

Pad Detector threshold 

0*VDD/16 – 1*VDD/16 61 (right endpoint of potentiometer) 

1*VDD/16 – 2*VDD/16 66 

2*VDD/16 – 3*VDD/16 80 

3*VDD/16 – 4*VDD/16 90 

4*VDD/16 – 5*VDD/16 112 

5*VDD/16 – 6*VDD/16 136 

6*VDD/16 – 7*VDD/16 192 

7*VDD/16 – 8*VDD/16 248 

8*VDD/16 – 9*VDD/16 320 

9*VDD/16 – 10*VDD/16 384 

10*VDD/16 – 11*VDD/16 480 

11*VDD/16 – 12*VDD/16 640 

12*VDD/16 – 13*VDD/16 896 

13*VDD/16 – 14*VDD/16 1344 

14*VDD/16 – 15*VDD/16 1920 

15*VDD/16 – 16*VDD/16 2560 (left endpoint of potentiometer) 

Measured potentiometer 

voltage “VDD_RF-QS2” (V1) 

Measured potentiometer 

voltage “GND-QS2” (V2) 

Expected detection 

range 

Comment 

1.412 V 0.173 V 7.66 m Rightmost position 

1.378 V 0.207 V 6.9 m  

1.296 V 0.289 V 5.8 m  

1.144 V 0.441 V 5.4 m  

0.929 V 0.656 V 4.76 m  

0.794 V 0.791 V 4.1 m  

0.665 V 0.92 V 2.48 m  

0.577 V 1.008 V 2.1 m  

0.388 V 1.197 V 1.7 m  

0.229 V 1.357 V 1.2 m  

0.108 V 1.477 V 0.93 m  

0 V 1.585 V 0.45 m Leftmost position 
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4.2.5 QS3 – detector hold time 

 
Figure 15 Rotation direction of R_QS3 potentiometer – detector hold time 

QS3 is used to select the hold time of the TDet output, and it is written into Reg10 as described in the user's 
guide to BGT60LTR11AIP [3]. 

Table 6 QS3 settings – detector hold time 

 

 

 

 

 

 

Pad Detector hold time 

0*VDD/16 – 1*VDD/16 100 ms (right endpoint of potentiometer) 

1*VDD/16 – 2*VDD/16 500 ms 

2*VDD/16 – 3*VDD/16 1 s 

3*VDD/16 – 4*VDD/16 2 s 

4*VDD/16 – 5*VDD/16 3 s 

5*VDD/16 – 6*VDD/16 5 s 

6*VDD/16 – 7*VDD/16 10 s 

7*VDD/16 – 8*VDD/16 30 s 

8*VDD/16 – 9*VDD/16 45 s 

9*VDD/16 – 10*VDD/16 1 min. 

10*VDD/16 – 11*VDD/16 90 s 

11*VDD/16 – 12*VDD/16 2 min. 

12*VDD/16 – 13*VDD/16 5 min. 

13*VDD/16 – 14*VDD/16 10 min. 

14*VDD/16 – 15*VDD/16 15 min. 

15*VDD/16 – 16*VDD/16 30 min. (left endpoint of potentiometer) 

Rotate the knob of potentiometer R_QS3 clockwise to reduce the 
detection hold time. 
Rotate it counterclockwise to increase the detection hold time.  
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Due to mechanical tolerances and manufacturing differences in the potentiometer, it is difficult to predict the 
degree of rotation of the potentiometer. Table 7 gives an orientation for the configuration of the QS3 voltage, 

hence the radar’s hold time. Please note that your values may differ slightly from the values below. 

Table 7 Measured voltage vs. hold time of QS3 potentiometer in autonomous mode (for reference 
only) 

4.2.6 QS4 – operating frequency 

QS4 is used to select the device operating frequency by configuring the PLL. Frequency is also dependent on 
the Japan e-fuse. The QS4 signal can be adjusted by using the tri-state switch “QS4: freq” on the Radar 
Shield2Go. 

Table 8 QS4 settings – operating frequency 

Measured potentiometer 

voltage QS3 

Expected detector 

hold time 

Measured detector 

hold time 

Comment 

0 V 100 ms  Less than 1 s Rightmost position 

0.112 V 500 ms Less than 1 s  

0.279 V 1 s 1.37 s  

0.355 V 2 s 2.21s  

0.493 V 5 s 5.54 s  

0.713 V 30 s  30 s  

0.898 V 60s 60s  

1.06 V 90 s 90 s  

1.134 V 2 min. 2 min.  

1.248 V 5 min. 5 min.  

1.452 V 15 min. 15 min. Leftmost position 

Switch position –  QS4 

mode 

QS4 Operating 

frequency 

PCB configuration 

Left position Ground 61.1 GHz Not important 

Middle position (floating) Open (default) 61.2 GHz Not important 

Right position 100 kΩ to VDD 61.3 GHz R_QS4 = 100 kΩ 

Right position VDD 61.4 GHz R_QS4 = 0 Ω (default) 

*DNP = R_QS4 is assembled by default with a 0 Ω resistor. Exchange for a 100 kΩ [0603 size imp.] resistor. 
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5 Hardware circuits  

5.1 Power supply 

This Shield2Go needs to be connected to a 3.3 V DC power supply that provides at least 150 mA. Connect +3.3 V 
to pin 7 and ground to pin 6 (GND).  

The BGT60LTR11AIP Shield2Go is equipped with a 150 mA Infineon LDO TLS202A1 that provides the necessary 
1.5 V for the radar IC, as seen in Figure 16. 

 

Figure 16 Power supply circuit 

5.2 Level shifters 

The Radar Shield2Go is equipped with 3.3 V to 1.5 V level shifters. The level shifters are responsible for 

transforming the voltage signals to 3.3 V. Hence, all inputs/outputs of the Radar Shield2Go work only with 3.3 V 
voltage levels. For use with, e.g., 5 V levels, further level shifting is required. The level shifting on the 

BGT60LTR11AIP Shield2Go is shown in Figure 17. 

Infineon’s MyIoT adapter offers the perfect solution for such a purpose, and is capable of transforming 3.3 V to 5 
V, making the Shield2Go usable with 5 V boards. See the MyIoT adapter manual for more information. 

https://www.infineon.com/cms/en/product/evaluation-boards/my-iot-adapter/
https://www.infineon.com/dgdl/Infineon-quick_starter_guide-Shield2Go_MY_IoT_Adapter-GS-v01_00-EN.pdf?fileId=5546d462677d0f460167bbdbd8521af9
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Figure 17 Level shifter circuit (3.3 V to 1.5 V, and vice versa) 

5.3 LEDs 

The Radar Shield2Go comes with four different LEDs: 

• The green PWR LED indicates that the +3V3 pin is connected to a power supply. 

• the blue motion LED indicates any movement detected by the radar, 

• while the red direction LED indicates an approaching or departing object.  

Table 9 shows the behavior of the motion (blue) and direction (red) LEDs, in case the MMIC radar detects an 

object’s presence or its direction of movement. 

Table 9 LED behavior when a movement or target is recognized by the BGT60LTR11AIP MMIC  

LED Mode Comments 

Blue – motion On – target detected 

Off – target not detected 

TD is an active low signal 

Red – direction On – depart departing 

Off – target approaching 

PD is an active low signal 
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The motion LED and direction LED are directly connected to target detection pin 13 (TD) and phase detection 
pin 9 (PD). The shield has two LEDs to indicate the motion detection (blue) and the target’s direction of motion 

(red), as shown in Table 9. R10 and R11 are current-limiting resistors. The digital block within the detector in 
the MMIC evaluates and sets the TD/PD outputs of the BGT60LTR11AIP MMIC. Target detected (TD) output is 

active low. It is set to low when enough events on the pulse train are counted. Phase detected (PD) output is 
used to show the direction of the detected target. It is only valid in the case of a detected target, and it is set to 
high for approaching targets and set to low for departing targets. 

 

Figure 18 LED schematics 

For the TD pin, when no target is detected, the voltage level appears to be 3.3 V on this pin. The PD pin voltage 

varies, depending on the direction of the moving object. While the target is approaching, the pin puts out 3.3 V, 

and when the target is departing from the radar it puts out close to 0 V. These pins can be read from analog pins 
or digital pins TD and PD.  

Additionally, the yellow LED1 can be controlled with P10 via an external GPIO of a microcontroller and serves as 
a custom user LED. Unsolder jumper J1 if you want to disconnect LED1 from P10. Figure 18 shows the 
schematics of the four LEDs. 

5.4 Crystal oscillator 

The MMIC requires an oscillator source with a stable reference clock providing low phase jitter and low phase 

noise. The oscillator is integrated inside the MMIC. This saves current consumption, as crystal oscillators 

consume only a few milli-amperes and run continuously. The Radar Shield2Go uses a 38.4 MHz crystal 

oscillator, as seen in Figure 19. 

 

Figure 19 Oscillator circuit with 38.4 MHz crystal 
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5.5 External capacitors 

The BGT60LTR11AIP MMIC is highly duty-cycled and performs a sample and hold (S&H) operation for lower 
power consumption. The S&H switches are integrated into the chip at each differential IQ mixer output port. 
They are controlled synchronously via the internal state machine. The capacitors between S&H and the high-
pass filter (HPF) are external. C10, C11, C14 and C15 are 5.6 nF capacitors used as “hold” capacitors for the S&H 

circuitry. They can be configured for different pulse-width settings, as shown in Table 10. C8, C9, C12 and C13 

are the DC blocking (or high pass) capacitors. They are 10 nF to get a high pass of 4 Hz (if internal high-pass 
resistor RHP = 4 MΩ). It is not recommended to use higher values, as it will affect the analog baseband (ABB) 
settling time. The DC blocking capacitors are important because the mixer output has a different DC voltage 
than the internal ABB. 

 

Figure 20 External capacitors on the BGT60LTR11AIP Radar Shield2Go 

In Figure 20 the external hold (𝐶ℎ𝑜𝑙𝑑) and high-pass capacitors (𝐶𝐻𝑃) are shown for all four branches in the 
differential IQ configuration. 

Table 10 Recommended hold capacitors (C10, C11, C14 and C15) for different pulse widths (PW) 

Charging time of the hold capacitor (𝐶ℎ𝑜𝑙𝑑) is limited to the selected pulse width. Shorter pulse widths require 

smaller 𝐶ℎ𝑜𝑙𝑑  to get it ~ 90 percent charged during one pulse. Rise-time is controlled by the 𝐶ℎ𝑜𝑙𝑑  itself, and the 
internal mixer output resistance of 300 Ω in each branch. 

Pulse width (µs) Hold capacitor value (nF) 

3 4.7  

5 (default) 5.6 (default) 

10 15 
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IFIAix

Chold

CHP

IFIAox

S&H switchRmixer_out

Pulsed 
mixer 

output 
(AC + DC 

superposed)

RHP

Vcc/2

BGT60LTR11AIP

External capacitors  

Figure 21 Internal circuit of the BGT60LTR11AIP connected with adjustable external capacitors 

Longer pulse width can have a higher 𝐶ℎ𝑜𝑙𝑑  value. This leads to a reduced bandwidth of the RC filter 

(𝑅𝑚𝑖𝑥𝑒𝑟_𝑜𝑢𝑡   and 𝐶ℎ𝑜𝑙𝑑). Consequently, there will be lower baseband noise because of reduced noise folding 

bandwidth. 
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6 PCB design 

6.1 Layer stack-up and routing 

 

Figure 22 Layer stack-up of the BGT60LTR11AIP Radar Shield2Go 

The PCB is designed with a four-layer stack-up with standard FR4 material. Figure 22 shows the different layers 

and their thicknesses. In the routing on the PCB, the VTUNE pin on the BGT60LTR11AIP MMIC should be left 

floating. Any components added to the line, or a long wire connected can result in spurs.  

The MMIC is very sensitive to noises and electrical influences; therefore, the GND and PWR layers were 

separated from the signal layers (top and bottom). Additionally, to guarantee best performance of the radar, an 
elliptical space of 4 to 5 cm around the MMIC was kept free from any PCB components (except the power 
capacitors). 

6.2 Bill of materials 

Table 11 Bill of materials 

Qty Designator Package 

metric 

Package 

imperial 

Value Manufacturer order 

number 

1 C4 1005 0402 11 pF GRM1535C1H110GDD5 

1 C16 1005 0402 16 pF GRM1535C1H160GDD5 

1 Direction 1608 0603 Red LSM0603412V 

1 G1     TLS202A1MBV TLS202A1MBV 

1 LED1     Yellowish green SML-P12MTT86R 

1 Motion     Blue LSM0603463V 

1 PWR Green Green  XZBGR155W5MAV XZBGR155W5MAV 

1 R10   0402 100 R CRCW0402100RFK 

1 R23 1005 0402 6.8 k CRCW04026K80FK 

1 R24 1005 0402 27 k CRCW040227K0FK 

1 U1 BGA, 42 

pins 
  BGT60LTR11AIP BGT60LTR11AIP 

1 Y1   FH3840024Z FH3840024Z 
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6.3 Schematics 

 

  

Qty Designator Package 

metric 

Package 

imperial 

Value Manufacturer order 

number 

2 C1, C3 1608 0603 10 µF GRM188R61E106MA73, 

GRM188R61A106KE69 

2 C5, C6 1608 0603 150 nF GRM188R61A154MA01 

2 L1, L2 1005   600 R MMZ1005B601CT000 

1 QS1: mode     CJS-1200B1 CJS-1200B1 

1 QS4: freq.     CJS-1201B1 CJS-1201B1 

2 R13, R20   0402 100 k CRCW0402100KFK 

2 R_QS2, R_QS3     10 k 22AR10KLFTR 

2 U4, U5     SN74AVC4T245DGVR SN74AVC4T245DGVR 

3 R1, R2, R11   0402 330 R CRCW0402330RFK 

4 C8, C9, C12, 

C13 
1005 0402 10 nF GRM155R60J103KA01 

4 C10, C11, C14, 

C15 

1005 0402 5.6 nF GRM155R71E562JA01 

7 C2, C7, C17, 
C18, C19, C20, 

C21 

1005 0402 100 nF C1005X7R1H104K050BB 

7 R3, R6, R7, R8, 

R12, R21, R22 

    10 k CRCW040210K0FK 

3 R14, R17, R19 1608 0603 100 k RC0603FR-07100KL 

3 R_QS1, R_QS4, 

R9 

  0603 0 R RC0603JR-070RL 

4 R15, R16, R18 1608 0603 100 k RC0603FR-07100KL 

2 R4, R5   0603 0 R RC0603JR-070RL 

1 S1 8-pin   8-pin, 2.54 mm pitch, male 2211S-08G 

1 S1 9-pin   9-pin, 2.54 mm pitch, male 2211S-09G 
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